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1 New General Features 

1.1 New Installation Options 
V10 presents new installation options. Now the user can choose between Typical and 
Custom installation. The latter one is recommended only for advanced users. The third 
option is for those users, who only wish to add machine postprocessor and therefore don't 
need to run the whole installation. 

 

1.2 DNC Integrated into cncKad Installation 
From now on the DNC installation can be run from within cncKad installation. When running 
cncKad installation you can choose between installing cncKad Suite and DNC, or install 
both together. 
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1.3 Working with SQL Server 
From now on cncKad can work with SQL Server. 

On the cncKad Server tab of Workspace Settings dialog you can select whether you want 
to work with Local Database or with Server Database. For the latter one you need to 
configure cncKad Server Address. 

 

When working with SQL server on a few tabs you will see the following icon:  . 
Since you are working now on the shared database, this lock protects from making 
undesired changes to the whole database, because they will affect all the cncKad users in 
your factory. If you are approved by your factory administrator to replace some values inside 

the database, you will be able to unlock this icon  and enter the modifications.  

1.4 Changes to Import Setup Layout View 
The Import Setup dialog, both in cncKad and in AutoNest, has been completely 
transformed. It contains now more information, thus becoming more efficient import tool. 

The dialog is split into four tabs, each one containing different import information. 

 
In this tab we see a few new pieces of general information: 

 the minimal text size 

 an option to ignore CL/LF for HPGL 

 a possibility to create SubNest for DXF/DWG files already at this stage 
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In addition to functions familiar to us, here we can: 

 Use Layers Filter 

 Use Color Conversion Map 

 Convert Lines to Bend Lines By Color/Line Type 

While importing a file from AutoCAD here you have an option to use entity's color and style 
imported from AutoCAD (set in Color Conversion Map). 

 
Here we can just see the buffer set for parts imported from cncKad. 



cncKad 

7 

 
This tab also provides us with new features, such as an ability to: 

 Rotate The Part 90 Deg If Y Size is Bigger Then X Size  

 Convert Lines Smaller the Tolerance to Points 

 Identify Parts in Geometry – available for DFT and DXF/DWG files 

1.5 Importing a Subpart From DXF File 
From any DXF you import you can save a part as a Sub-Part. 

 
After loading DXF file in cncKad, select a Save Sub-Part option from File Menu. On the 
sheet mark the part you want to save (highlighted in blue). After saving the sub-part under a 
new name and confirming your action the following dialog will open: 
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Here you can set some general parameters for you Sub-Part, that will be saved with it, such 
as material, thickness, cutting technology parameters (only for cutting machines) and bend 
parameters.  

You also can add this Sub-Part directly to one of your Order files. 

1.6 Export Dimensions to AutoCAD 
Part with dimensions is exported to AutoCAD including the dimensions. 

1.7 Units Conversion 
When switching (in Settings Menu => Set Working Units) from mm to inch, or vice versa, 
now all your measures made in one unit will be automatically transformed to the other one. 
With just one click all the tools, geometry, CAMs, material thickness and Cutting 
Technology Table measures will be converted. 

 

If you work with inches, before updating from a former cncKad version to V10 make sure 
that your old cncKad version is set to inch, before you close it! Otherwise, when updating to 
V10 you will receive wrong measures (e.g. huge size tools), due to units conversion 
misinterpretation. 
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1.8 Customizing Feature 

 
In Settings Menu there is a new feature allowing you to customize Commands, Toolbars, 
Menus, Keyboard Shortcuts, Toolbar Settings and Toolbar Options. 

 

1.9 Part Preview in Thumbnails 
Now you can see the part's "preview" while viewing the parts' list as thumbnails. 

This applies only to files saved from V10 and onwards. 

This is an example of viewing parts' thumbnails from Open Part dialog: 
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And this is an example of viewing parts' thumbnails from Windows Explorer window: 

 

1.10 CAM Editing in Manual Nesting 
When working on an NST file, some CAM Menu items are now accessible in addition to a 
regular Nest Menu, allowing you to edit your Nest definitions.  
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In contrast to the previous versions now you can Edit CAM on the parts placed on your 
Nest. Any changes done here to your part's tooling will not affect the original part's file. 

 

If there are many instances of your part placed on the Nest, you can choose whether to 
apply the changes only to one part's instance, or to all instances. 
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If you decide to apply them to Only this Instance, they will be implemented only to the 
specific occurrence. 

If you decide to apply them for all, the changes will be executed on all the instances of this 
part, placed in the Nest. Depending on which option you have chosen for "all" – they will be 
implemented either to All Instances of this Part with Same Angle and Mirror or to All 
Instances of this Part. 

If all the instances of your part are at the same angle and mirror, you will be given only two 
options to choose from: 

 
However, if there is only one instance of the part, no dialog will appear. 

 

Below you can see an example of Edited CAM and different lead-in entry onto parts in NST 
file: 

 

1.11 Show Program Preview in Simulation 
This new option of Simulation View Menu allows you to preview the cut path, before running 
the NC program.  

On the picture below you can see the program preview, by default colored in gray together 
with processing, marked in yellow: 
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The default Program Preview Color can be changed from Simulation Settings Menu => 
Simulator Settings dialog: 

 

1.12 Colors in Simulation 

 This option is available for Amada Machines only.  

Now it is possible to view colors for various cutting speeds: 
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1.13 Convert Text to DFT 
This new function of Draw Menu => Dim/Text allows an easy switch from Simple Font Text 
to a DFT Text. 
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This is how it is being done: 

 

1.14 Browsing For DFT Font Directory 
In Settings => Workspace Settings => DFT Text tab the user can browse and choose by 
himself the DFT Fonts Directory. 

 

1.15 Show Open Contours 
This new option of View Menu allows keeping Open Contours ends on the screen. 

In the former cncKad versions, after running "Geometry Check", if there were open 
contours, red crosses would appear on the screen to help user to identify the problem. Any 
next action that the user would do in cncKad would erase these signs. With this new option 
the cross can now be displayed all the time on the screen. 
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1.16 Explode Multiple Parts Confirmation Dialogs 
After selecting the Explode Multiple Parts option from Transform Menu the following 
dialog will appear: 

 
When you confirm, the parts will be exploded on the sheet and the following confirmation 
dialog will pop up: 

 

1.17 MARK Tool Support for Engraving 
When using the Engrave Entities and Engrave Text options, now you can select a special 
engraving tool: MARK01.T. 

 

1.18 Changes to Pre-Punch Settings 

 This option is for combinations machines. 

In Settings Menu => Machines Settings => Cuttings Parameters tab => Piercing section 
now you can define default pre-punch tool, with tool number and tool ID, instead of User 
Defined Hole Diameter, as it used to be before. 
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1.19 Tool Data Dialog Changes 
From now on the Type Properties tab of Tool Data dialog will be visible only from Used 
Tools dialog. 
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1.20 Changes in Used Tools' Dialog 
1. Double Click on tool name should open Type Properties tab of Tool Data dialog.  

 
2. Since there is no Type Properties tab for laser tools, the double click with open the 

Common tab of Tool Data dialog. The Tonnage section is grayed and zeroed. 

 

1.21 Changes to Tapping Tool Data Type Properties 
The Type Properties tab of Tapping Tool Dialog now supports Speed and Offset per 
Thickness, Top Dead Center and Extrusion (Burring) types: None, Up and Down. 

 

This is an example of Tapping tool properties with No Extrusion: 
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Here – with Extrusion Up: 

 
 

And here – with Extrusion Down: 

 

1.22 MJ Trapeze Tool 
A new microjoint trapeze tool was added to cncKad. 
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1.23 Deburr Tool 
This new tool type was added to cncKad: 
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1.24 Support of Multi-Selection Parts in Deposit Dialog 
In Part Unload Deposit dialog now with the aid of Ctrl key and a mouse click or Ctrl+A keys 
you can select a few parts to be deposited simultaneously. 

 
After selecting a few parts at a time you can not only select the Deposit Mode for them, but 
also Set Deposit and move them together. 

1.25 Second Pickup Layout Support 
Second pickup layout activation is now available for machines with absolute Y. The second 
layout will be activated automatically in Manual Nesting mode, during NC creation, if the 
primary pickup layout exceeds its Y limit. Function Ask will demonstrate the active pickup 
layout. 

1.26 Keyboard Buttons Support in Part Unload 

 
From this version of cncKad you can use: 

 Keyboard arrows to move the unload sections (aside of clicking arrows in the 
unloader box) 

 Enter key to confirm cups selection (aside of clicking the V box) 

 "P" key to select the cups inside the part border (aside of clicking the P box) 
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1.27 Table Grid Zoom 
Now the table grid size changing is enabled with the by aid of Ctrl + Middle Mouse Wheel. 
The changes will be stored and restored when grid is closed and opened. 

This applies to ALL Table Grids in cncKad, AutoNest and Simulation, including: 

Simulation (NC Window), Tool Library, Turret Setups, Used Tools, Cutting Technology 
Table, Part Handling, and AutoNest ORD 

1.28 Use Entity's Color and Style While Import from AutoCAD 
While importing a file from AutoCAD you have an option to use entity's color and style 
imported from AutoCAD. 

1.29 Split Sheet Lines Calculation 
Split Sheet lines calculation will take into account Cut Sheet lines, if they exist. 

1.30 Changes to ToolBlockOrder .mdl Command 
If some tool has several sequences, if ToolBlockOrder is ORDER_BY_NC, only the first 
instance of this tool will be used during NC or NC Report generation. 

1.31 Support for FinnPower XML NC Format 
Now it is possible to generate the NC code on FinnPower machines in XML format. 

1.32 Simulator Code Ignores a String inside FinnPower NC Code 
Adding a string to the simulation definitions file under the numbers /350, /351 ... to /360, will 
instruct the simulation to ignore those specific strings inside any line in the NC code.  

This option already exists in Amada Machine and now is implemented for FinnPower. 

1.33 Changes to Simulator window 
When resizing the whole Simulator window, the NC text pane retains its size. 
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2 PH (Part Handling) Support  
This new function of CAM Toolbar allows you setting default Part Handling parameters for 
punching and cutting. Any setting you define will concern particular material and thickness 
combination and they will be machine specific. This means that when you change material, 
its thickness, or select a different machine, the parameters you set just before will not be 
valid anymore. 

 

On the following example we set the Part Handling parameters for 2 mm Stainless Steel 
for Amada LC1212: 

 
This option allows the user to add unlimited number of contour sizes defined by two 
dimensions: X and Y. For each defined contour size you can assign action for a part or a 
hole – placing MicroJoints, making Push Out, picking up the part/hole or stopping the 
machine – depending on your machine abilities. You can also set the entry point (lead-in) 
position, define MicroJoints placement and their width, and set the Approach for MicroJoint. 

The order of the lines is critical as cncKad scans the lines from the First (top-most) line! 

If a line matching the Contour Size is found – it will be used, even if other lines BELOW it 
also match the Contour Size. 

 

The Part Handling is accessible from Part Handling tab both in AutoPunch and AutoCut 
dialogs. There you can choose the MicroJoint placement most suitable for your parts. 

 

See the example of AutoCut dialog: 
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Adding MicroJoints don't split the entity into multiple entities. Therefore when you run the 
AutoCut processing, the MicroJoints will not be deleted and they will behave as corners. 

 

And here you can see the example of AutoPunch dialog: 
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3 New Punch Features 

3.1 Crunch Circle with Two Tools 
This new option of Add Punch allows you to crunch a circular hole with two tools: 

 
 

That means that you can crunch the middle of the circle with one tool and nibble contour with 
another one: 

 
 

It is possible to use a rectangular tool to crunch with, as inner tool: 
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3.2 Crunch Trimmed Shapes 
V10 of cncKad supports "chamfered shapes" as a part of Irregular Shapes, including arcs: 

 

3.3 Changes to AutoPunch 
Important changes are implemented in AutoPunch for V10 of cncKad: 

 WireJoint will not be placed for arcs, if the latter ones belong to a hole. 

 AutoPunch will set punch direction to nibbles of some notches. 

 Arcs with included of a value angle less than 90° will be allowed to be automatically 
punched with cross tool. 

 Automatic SheetMaster – during AutoPunch the PushOut and PartUnload 
parameters will be taken from Part Handling table. 

 CAMs added from user predefined shapes will not be used for MicroJoints 

 If there is outside Y range geometry, AutoPunch asks what to do 

 The Shapes in Special Punching are sorted from small to big 

3.4 Placing MJ on Nibbled Entity 
While placing microjoint on nibbled entity and the nibbling tool is longer than entity, the 
nibbling tool will move accordingly. 
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3.5 Copy Profile in AutoPunch 
On Shapes tab in AutoPunch dialog you can now Copy Profile from one to another: 

 

3.6 Support Stacking In Part Unload  
Using Stacking option from CAM Menu you can stack parts also on DFT File: 
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3.7 Text Marking in AutoPunch 
On the Text Tab in AutoPunch dialog you can mark simple text, using marking tool. 

 

3.8 Trim at Sheet Edge 
If trim line lies on the edge of the sheet you will be able to trim it, checking beforehand the 
appropriate box in the Trim Sheet tab of Set Sheet and Clamps dialog: 

 
Trim sheet tool uses Tool ID from Tool Library. 

3.9 Turret Dialog Changes 
In V10 there are a few changes in Turret dialog: 

1. The base number of MultiTool is displayed. 
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2. The number of each and every MultiTool station is displayed. 

 
3. Double click on MultiTool base zooms it in, so that it fills in the whole turret display 

area, as presented below:  

 

3.10 Punching a Line with Regular and MJ Tool 
Now there is an option to punch a line with regular and MJ tool simultaneously. 

3.11 Nonexistent Tool Warning in SQL Mode 
When adding punch manually in SQL mode, you will be warned if the desired tool doesn't 
exist in your Tool Library. 
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4 New Cutting Features  

4.1 Laser Common Cuts and Bridge Marked in Pink 
Anytime you will create laser common cuts or place a bridge, they will be denoted in pink 
color. 

Common Cuts: Bridge: 

 

 

4.2 Bridge Cutting for Plasma and Laser Machines 
From this version onwards cncKad supports Bridge and Chain Cutting for Plasma and 
Laser cutting machines. The place of the Bridge can be defined with the help of the Snap 
options. 

This time and money saving option creates one cut, processing all the parts with just one 
Pierce: 

 
The processing will start from the first part you click. The parts are always being cut 
clockwise, when running AutoCut, to ensure, that better side of the flame would be used on 
the part; otherwise the cutting direction comes from AutoCut tab. 

The Bridge Cutting can be also applied for DFT Text processing: 
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4.3 Changes in Manual Operations on Corner Microjoints for Laser 
1. Adding a MicroJoint to a corner while pressing Shift will add a MicroJoint to both 

sides of the corner.  

2. Deleting a MicroJoint on a corner will now be applied to both sides of the corner.  

3. Editing a MicroJoint while pressing Shift will edit both sides of the corner. 

4. Moving a MicroJoint will always move both sides of a corner, and pressing Shift will 
place it on both sides of a corner (if moving to one). 

 Note: The effect of pressing the Shift key can be inverted in Machine Settings 

dialog -> Cutting Parameters tab 

4.4 Marking Before Cutting Enhancement  
When the user requests to perform Marking Before Cutting Per Part (in Set Sheets and 
Clamps => Cutting Optimization tab => Marking Before Cutting section), and there are 
common cuts between parts, the actual order will be that cncKad will perform marking for 
the whole sheet and then continue with cutting as defined. 

4.5 Laser Reposition Support 
Laser Reposition is now supported. This allows the cuts that are larger than the working 
range to be split automatically. 

4.6 Bevel Angle in Add Cut 
This new option of Add Cut dialog, intended for laser, plasma, water jet and some flame 
machines, compensates the inclined, bevel cutting.  

This feature does not apply for laser cutting of a thin material. 
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4.7 Part Unload – Pickup before Final Cut 
This new option of Laser Part Unload is enabled only if the Last Cut is vertical. 

If PickupSequence equals 1, then Pickup point is at last cut, only if last cut is vertical. 
Otherwise – the Pickup follows after cut is finished (including Lead-out if one exists). 

4.8 Improvements to Edit Contour Entry 
1. When trying to move the entry point close to an entity’s endpoint, the first one will be 

changed to a STRAIGHT entry. cncKad will also perform a check, to see if this 
action is possible, and if not – the entry will be placed as STRAIGHT 90. 

2. When moving an entry you will receive a warning, if it destroys the part/nest. At that 
point you will be able to select whether to continue or not. 

4.9 Improvement of Entry Point on a Hole 
Now, when SIDE option is set to AUTO, in AutoCut => AutoCut tab, the hole corners with an 
angle bigger than 90 degrees will be considered as an entry point. 

4.10 Improvement of Entry Point on a Part 

 This applies only when Entry on Side and Entry on Corner options are set 

to AUTO, in AutoCut => AutoCut tab. 
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The entry point on a part will now be placed in a way so that the last cut will be placed on the 
strong side (where there is more material to support the dangling part). 

4.11 New Lead-in Options 
There are two new entry (lead-in/approach) options: 

 straight entry at 45 degrees, which applies to all types of entities 

 freehand entry for circles 
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5 New in AutoNest 

5.1 Colors in AutoNest 
Choosing one of the colors options: All green, Color by part or Color by job from the 

Zoom Toolbar  you can select how you want your 
parts to be displayed on the sheet: filled with green color or with other colors sorted either by 
part or by job. 

 

Here you have an example of color by parts: 

 
 

And here colored by job: 
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This option is useful e.g. when you have joined a few orders, to distinguish them easily. 

5.2 Generate DXF Files for Selected SubNests 
Selecting a SubNest and clicking the right mouse button, on the Info Bar in the SubNests 
section, will open a menu. From here you can export the specific SubNest to DXF file.  

 
Using Shift and Ctrl keyboard keys you can do multiple selection, and thus export to DXF 
many Sub-Nests at once. The same applies to generating NST or DFT files. 

5.3 Laser Common Cuts Distance 
In Laser Common Cuts the distance between parts should come from Cutting Technology 
Table and should equal Laser Beam Width, how it appears in Cutting Technology Table. 

 

In AutoNest, in a Global Info dialog you can set the Common Cuts Buffer, equal to the 
laser beam diameter, taken from Cutting Technology Table, for each part in the Order.  

In our example, we can see in Cutting Technology Table that Trumpf laser machine's beam 
diameter equals 0.15: 



cncKad 

37 

 
 

And this is how it is presented in Global Info dialog: 

 
After opening the nest in cncKad for parts' processing, cncKad will automatically read the 
beam diameter from appropriate table, when the user checks Perform Common Cuts in 
AutoCut dialog. 

5.4 Show Predicted Common Cuts 
When you select the Show Common Cuts option from View Menu and set the Common 
Cuts Distance, the AutoNest will predict and display edges that will be cut by common cuts. 
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This is how they will be highlighted on your Nest (in red): 

 

5.5 Label Report Support for SubNests 
Right now you can print Label Report also for SubNests – either for a specific one or for a 
few at a time. 

 

5.6 Creating ORD File 
Create\Load Order File option of AutoNest File Menu allows Importing and Batch 
Processing of DXF/DWG files, including Geometry Validation, setting Quantities, Material 
and Thickness for each part individually, as well as for a group of parts, processing them by 
Cutting/Punching (that depends on the machine you have), Nesting and NC Generation.  

All this with just a few mouse clicks! 
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On the picture above the DXF files have been selected, the quantities set. The default 
material and thickness as well as material and thickness for particular group of parts have 
been defined. Now we will Validate all the parts – this means that AutoNest will import them 
and run geometry checks. 

 When you run the AutoCut or AutoPunch options from this dialog, the relevant 

(correspondingly AutoCut or AutoPunch) dialog will be displayed and you will 

be able to define custom processing parameters. 

 
When all geometries are correct we can process them. In case they are not valid, click Edit 
button and Edit the particular geometry in cncKad. All the changes you will make and save 
there will be automatically updated in this dialog. 
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Now all the parts have been processed. Clicking OK button will load the parts to the main 
AutoNest window and there you will be able to nest them on the sheets. 

When you open an existing order, you will see an additional section of Adding Parts to 
Order. It enables you creating a new order from the parts you see, or adding those parts to 
already existing order. 
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As you have probably noticed, the Part Preview window is bigger now and is floating, so 
you can move it around the screen: 

 

5.7 User Defined Material and Thickness Saved For DFT 
If user defined other material for .dft file than the default one, it will be saved in this file after 
validation or auto process. 

 

5.8 Support Loading of Order Files in CSV Format in AutoNest 
The AutoNest module supports now order creation using simple Comma Separated Value 
(CSV) files as an alternative to the "traditional" ORD file format.  

 

Following is a description of all the changes and additions related to this new capability: 

 There is a new tab in the AutoNest workspace settings called ‘ORD CSV Map’, in 
which the user can define mapping of selected columns in any CSV file to ORD 
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parameters: 

 

 The user will be able to save multiple mapping files. These files have the extension 
OrdCsvMap, as you can see above. 

 The user will be able to select the active ORD mode – the regular (existing) ORD 
mode or the (new) CSV mode; if CSV mode is selected – the user must select also 
an active map file. 

 

Here is a brief description of the process of creating an order in CSV mode: 

1. The user creates a new order selecting the Create/Load Order File command from 
File Menu 



cncKad 

43 

2. The system prompts for a CSV file (not ORD!) 

 
 

3. The user selects the required CSV file 

4. The AutoNest loads the file and interprets it according to the active map file 

5. The Create Order dialog appears with the relevant data, according to the number of 
rows in the CSV file 

 
At this moment the system is EXACTLY in the same situation as after loading a 
regular ORD file (and so does the rest of the process!). 

5.9 Support of Automation Report in CSV Format 
In addition to "txt" automation report now you can select "csv" report file in Settings Menu => 
Report Settings => AutoNest Report Settings tab => Template File for Automation Order 
Report section. 
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5.10 Support Material Name Synonyms in CSV Order Mode 
Now AutoNest supports CSV order file in which the material is specified by a synonym 
instead its ID number.  

For example: suppose that in the CSV file the material Steel appears as "STL Type B-7". In 
order to use this CSV (as it is) the user simply defines the appropriate "synonym" in the new 
Material Synonyms table in Settings -> Workspace Settings -> ORD CSV Map. 

5.11 Blanks Processing 
Blank parts can be now processed by cutting. 
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6 New Bending Features 
In V10 there are many new bending features.  

6.1 Bend Lines Parameters dialog 
There are changes to Bend Line Parameters dialog, accessible from Draw Menu or the 

Bend Lines Toolbar : 

 
When creating (or editing) a bend line, you can choose the method in which the bend 
compensation of this line shall be calculated. You can select the traditional method – using 
the global sheet K factor and a specified bending radius, or to Selected Bend Tool 
composed by a combination of the two characteristics of the bending tool – the punch radius 
and the V Opening (also known as the "Die" size). You can set the parameters of chosen 
method by yourself or decide to implement Global Bend Parameters. 

If you have selected a bending tool, the cncKad shall calculate the bending compensation 
using the bend deduction table. 

See the following example: 
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When you select two (or more) bending lines for edition, drawn using different options, in the 
Bend Line Parameters dialog only the options common for them will be editable by default.  

 
The above dialog presents the options editable by default for the following selection: 

 

6.2 Used Bend Technology Table & Bending Compensation Mode 
When opening a New Part in cncKad or the Sheet tab of the Set Sheets and Clamps 
dialog, there, next to the Used Cutting Technology Table section (in cutting machines), you 
will find, corresponding to it, the Used Bend Technology Table section.  

Beneath you will find Bending Compensation Mode section, in which you can choose 
between setting a Bend Line K Factor or Bending Tool for your part.  

This is how it looks in New Part dialog: 
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For Punch Machines this dialog looks this way: 

 
 

And this is how it looks on the Sheet tab of Set Sheet and Clamps dialog. 
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6.3 Changes to Bend Display Lines tab 
On the Bend Lines tab of Settings => Workspace Settings dialog there are a few new ways 
of displaying bend lines – now only from here you can choose what information you want to 
be displayed on your bending lines.  
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Additionally there is a new section of Bend Angle Display Mode. Choosing either a 
Product Angle or a Bending Angle you set angle of the displayed bending line. Product 
Angle will display the angle of actually bended line, and the Bending Angle will display the 
angle by which the line was bended. 

See the difference presented on the below picture:  

 

6.4 Bending Table tab 
In Settings => Workspace Settings dialog there is a new Bend Factors tab. It contains bend 
factors tables, based on Material, Thickness combination. If you change either of them, the 
data in the table will change accordingly. 

 

There are also three compensation display modes: D, D/2 and E where, D stands for Bend 
Deduction and E stand for another variation: 
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Mode D: 

 
 

Mode D/2:  
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Mode E:  

 
 

Here you can copy material and thickness from one to the other, similarly to the Cutting 
Technology Table dialog. You also have an access to which enables you Bend Technology 
Material Table which allows you to select the most suitable bend material for you, and add 
your own material type. 

 
 

Apart from that you can also Fill Row Missing Compensations. Entering the desired data, 
for a specific cell, let say – at 90 degree – in the Fill Row Missing Compensations dialog, 
will automatically estimate the lacking data values of other, empty cells in the newly created 
row. 
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And this is how the estimated results would look like: 

 

6.5 Laser and Bend Technology Materials 
Laser Technology Material of Settings = >Workspace Settings dialog => Material tab => 
Edit Material button is associated with Bend Technology Material. For each Laser 
Technology Material you can assign an appropriate Bend Technology Material. 

 

6.6 Mark Bend Lines 
This new option is accessible from CAM Menu. 

 
Selecting it you will be able to mark your bending line with punch or engrave, depending on 
machine type you are working with. If you are working on combination machine, you will be 
presented with both options: 

 

Mark by Punch: 
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Mark by Engrave: 
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7 New Tube Features 

7.1 Intersections With Tubes On Edge Are Trimmed 

 This option is valid for single and double penetration, and insertion. 

Intersections with tubes on edge are now trimmed. If the diameter of the tube used for the 
intersection is smaller than the tube being processed, and the intersection falls on an edge, 
the cut will be trimmed, so that only what is inside the tube is processed. 

  

7.2 Merge Intersections 
This new operation allows the automatic merging of intersections that share a common 
space, i.e. 2 or more tubes that intersect another tube in the same place, but at different 
angles. 

 

Here is the example of a such a tubes' intersection before merging: 

 
And here the intersections were merged: 
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7.3 Footer for Tubes 
Now the footer and the dead zone for tubes can be previewed on the screen. cncKad will 
issue a warning during NC code generation, if a cut is in the dead zone.  

7.4 New Attributes For Arcs In Rectangular Tubes 
In machine MDL file you can add attributes for arcs in rectangular tubes: Add BeforeCut and 
AfterCut.  
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8 New in CAD Link 

8.1 General CAD Link Enhancements 

 Faster update export algorithm 

 Batch Export 

 More customization options in Settings & Part Properties dialogs 

 New Toolbars and Ribbons 

8.2 64 bit compatible 
New CAD Link is fully compatible with 64 bit Solid Edge 20, ST and ST2, ST3, SolidWorks 
2008, 2009, 2010, 2011 and Autodesk Inventor 2009, 2010 and 2011.  

8.3 Solid Edge ST/ST2/ST3 Support 
CAD Link supports Solid Edge ST/ST2/ST3 – synchronous Sheet Metal/Part technology. 

 

8.4 Fast Export Model 
Some parts are so complex, or have so many Pattern features, that regular exporting takes a 
long time. With the aid of this CAD Link option you can speed up the Export action 
considerably (depending on the part, can be 10-20 time faster). 

8.5 SolidWorks Multi-body Support 
CAD Link supports multi-body sheet metal design export into cncKad. 

 
CAD Link differentiates between single part and assembly part. Now single part is always 
being treated as a multi-body part.  

When there is a single body, the process will be the same as it used to be before. When 
there are several bodies with several flat pattern features, they will be exported as assembly. 
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In the following example there are two flat-pattern features for the multi-body sheet metal 
part: 

 
 

When a multi-body is exported, for each flat pattern feature, a designated .dft file will be 
created. Each file will be named with the following format: 
"OriginalPartName"_"FlatPattenName". 

 

8.6 New CAD Link Report 
The CAD Link Report supports multi-body parts and was redesigned, as follows: 

 

8.7 Text Conversion Support 
CAD Link supports Text Conversion directly from the Inventor's Flat-Pattern into the cncKad 
application. 
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This can be done by copying the text into the flattened part: 

 

And this is the resulting text copied into cncKad: 
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9 New Estimation Features 

9.1 Additional Pierces Costing For Estimation     
Now the job costing estimation appends an additional cost per each pierce in the job. 

 
The cost per pierce is set by the user in the Estimation Settings dialog: 

 
This means there are new tokens for the total pierce cost of the entire job: 
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9.2 Runs 
According to user flag - all the costing calculation results will be multiplied by the 
actual number of sheets. The results will be seen on the Estimation Report: 

 


